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1	 Introduction

In 2012, Bio-Rad’s PrimePCR™ assays set a new standard for real-time PCR gene 
expression analysis. We collaborated with leaders in real-time PCR to design, optimize, and 
experimentally validate every primer pair. Products are available as individual SYBR® Green 
assays, individual probe assays, pathway and disease panels, and custom-configured 
plates. Reference gene and experimental control assays are also available. Assays are 
validated for use with Bio-Rad’s amplification reagents. All PrimePCR assays and panels can 
be ordered online at www.bio-rad.com/primepcr. 

PrimePCR Assays, Panels, and Controls 

SYBR® Green Assays
Transcriptome-wide assays are available for gene expression analysis. Individual assays are 
provided as a 20x stock solution of 200, 1,000, or 2,500 reactions. Each PrimePCR assay 
provides a Unique Assay ID, which can be easily tracked and reported in publications. 

Probe Assays
5' exonuclease probe assays are available for gene expression analysis. Each assay can be 
labeled with a FAM, HEX, Tex615, Cy5, or Cy5.5 fluorophore. Individual assays are provided 
as a 20x stock solution in 500, 1,000, or 2,500 reactions. Each PrimePCR assay provides a 
Unique Assay ID, which can be easily tracked and reported in publications. 

Predesigned Pathway and Disease Panels
A wide range of pathway- or disease-specific gene panels are available in 96- or 384-well 
plates. Primer pairs are lyophilized in the wells on the plate. Plates are designed for use with 
SYBR® Green detection chemistry and include experimental controls and reference assays. 
Plates are available for all major real-time PCR instruments (see the list of compatible real-
time instruments under Reagents and Equipment).
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Custom Plates
96- and 384-well PCR plates can be user-designed with PrimePCR™ SYBR® Green assays. 
Custom primer assays can also be added. Primer pairs are lyophilized in the wells on the 
plate. Plates are available for all major real-time PCR instruments, and can be designed with 
or without experimental controls.

PreAmp Assays
PrimePCR PreAmp assays are available for unbiased preamplification of target genes from 
small quantities of cDNA. Each assay is provided as a 100x stock solution and corresponds 
to a SYBR® Green or probe gene expression assay. 

DNA Templates
Assay-specific synthetic DNA templates are designed to give a positive PCR result when 
used with the corresponding SYBR® Green or probe assay. Templates are provided as a 20x 
stock solution of 200 reactions.

Experimental Control Assays
Experimental control assays are available for RNA quality assessment, genomic DNA 
contamination, reverse transcription, and PCR performance. Controls can be ordered as 
individual assays or preplated on predesigned or custom PCR plates.

Reference Gene Assays
Commonly used reference gene assays are available to normalize for variation in the amount 
of input messenger RNA (mRNA) among samples. Assays can be ordered as individual 
assays or added to a custom plate. Predesigned reference gene panels are available in  
96- and 384-well plates.

Droplet Digital™ PCR (ddPCR™) Probe Assays
Copy number variation and mutation detection assays have been expertly designed and 
validated for use with the QX100™ and QX200™ Droplet Digital PCR platform. Probe assays 
are labeled with a FAM or a HEX fluorophore, and are available in 200, 1,000, and 2,500 
reactions. Please see the PrimePCR ddPCR product inserts for detailed procedure and 
assay information.

Shipping and Storage
PrimePCR assays and plates are shipped at room temperature. Upon receipt, store product 
at 4°C (up to 12 months). For long-term storage, store at –20°C. 

If storing assay at –20°C, prevent oligonucleotide degradation by aliquoting the total volume 
into smaller volumes to minimize the number of freeze-thaw cycles. 

cDNA synthesis kits and supermixes are shipped on dry ice and should be stored at –20°C. 
Refer to individual product manuals for more details.
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Reagents and Equipment 

Consumables and Equipment Needed for Gene Expression Analysis
■■ cDNA synthesis kit 

■■ Centrifuge

■■ Gene expression analysis software

■■ Microfuge tubes

■■ Nuclease-free pipet tips and tubes

■■ Nuclease-free water

■■ Optical seals

■■ PCR plates or strips (if not using a preplated panel)

■■ Pipets — single channel and multichannel

■■ Purified RNA samples

■■ Real-time PCR detection system 

■■ SYBR® Green or probe supermix 

■■ TE buffer (pH 7.5, nuclease-free) — use for dilution of reverse transcription (RT)  
control template 

■■ TE buffer with 10 ng/ml tRNA (pH 8.0, nuclease-free) — use for standard curve dilutions

Guaranteed Performance
PrimePCR assays are guaranteed to perform with the following qPCR reagents:

■■ iScript™ advanced cDNA synthesis kit for RT-qPCR*

■■ iScript cDNA synthesis kit

■■ iScript reverse transcription supermix for RT-qPCR

■■ SsoAdvanced™ PreAmp supermix 

■■ SsoAdvanced™ SYBR® Green supermix*

■■ SsoAdvanced universal probes supermix 

■■ SsoAdvanced™ universal SYBR® Green supermix 

■■ iTaq™ universal probes supermix

■■ iTaq™ universal SYBR® Green supermix

* Reagents used for validation report	
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Compatible Real-Time PCR Instruments
PrimePCR assays and panels are available for the following real-time PCR detection systems:

Bio-Rad

CFX96™, CFX384™, CFX96 Touch™, CFX384 Touch™, CFX Connect™, Chromo4™, iQ™, iQ™5, 
MyiQ™, MyiQ™2, Opticon™, Opticon™ 2

ABI 

7300, 7500 (standard and Fast), 7900 (standard and Fast, 96- and 384-well), ViiA 7 
(standard and Fast, 96- and 384-well), QuantStudio (standard and Fast, 96- and 384-well), 
StepOnePlus

Stratagene Mx

Eppendorf realplex

Roche LightCycler 480 (96- and 384-well)

Important:  Verify instrument and fluorophore compatibility.

Tips for Success
For a complete description of how to optimize a gene expression experiment, please visit 
the gene expression workflow section of our Applications and Technologies pages at  
www.bio-rad.com/en-us/applications-technologies/gene-expression-analysis.

Ensure High RNA Quality and Quantity
To obtain optimal real-time PCR results, start with high-quality RNA from all samples. 
RNases, salts, proteins, and other contaminants can compromise the integrity of RNA 
samples and may impact the performance of downstream enzymes used in reverse 
transcription and PCR reactions.

■■ Decontaminate the workspace of RNase, salt, and protein sources

■■ Limit the number of freeze-thaw cycles of RNA sample, ideally to one cycle

■■ Use screw-cap tubes for long-term RNA storage at –80°C

■■ Use nuclease-free plastics and solutions

■■ Determine concentration and purity of RNA prior to gene expression experiment

■■ Mass normalize RNA samples by dilution with nuclease-free water prior to the reverse 
transcription reaction
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Prevent and Monitor Genomic DNA Contamination
Genomic DNA (gDNA) present in real-time PCR experiments can cause inaccurate gene 
expression quantification. Although PrimePCR assays were designed for intron-spanning 
regions when possible, elimination of gDNA contamination is a best practice for high-quality 
qPCR results.

■■ Perform a DNA digestion step with DNase during RNA purification

■■ Include a gDNA experimental control to determine if gDNA is present (see DNA 
Contamination Control Assay in Step 3 of Chapter 2, Gene Expression Protocols)

Select Appropriate Reference Genes
Choosing an appropriate reference gene(s) to normalize for variation in the amount of 
input messenger RNA (mRNA) among samples is important for accurate gene expression 
analysis. Consult Chapter 6, Reference Gene Selection and Reference Gene Panels, to learn 
how to determine a stably expressed gene target for your samples of interest.

Calibrate the Real-Time PCR Instrument for Dyes and Fluorophores 
Prior to starting a qPCR experiment, verify that the real-time PCR instrument is compatible 
and calibrated correctly for the dyes and fluorophores chosen. CFX Manager™ software 
has a Dye Calibration Wizard with an easy guide to calibration (Tools > Dye Calibration 
Wizard). Bio-Rad’s CFX instruments are currently calibrated with pure dyes to correspond 
to PrimePCR fluorophore options before installation. Refer to the instrument manual to 
determine calibration settings, and calibrate accordingly if necessary.

Fluorophore/Dye Excitation, nm Emission, nm

SYBR® Green 494 521

5' FAM 495 520

5' HEX 538 555

5' TEX615 596 613

5' Cy5 648 668

5' Cy5.5 685 706

Use Optical PCR Plate Seals
Use optical seals for accuracy when collecting real-time PCR data. Adhesive seals and heat 
seals are available options. Bio-Rad recommends using the PX1™ PCR plate sealer with 
optical heat seals for consistently sealed PCR plates. Seals must fully enclose the PCR plate 
to prevent evaporation from the wells during thermal cycling. Evaporation is identified by 
analyzing technical repeats of data — specifically, if a well near the edge of the plate yields 
variable data, evaporation has likely occurred. 
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Determine the Threshold Setting
Determining placement of the threshold line is important for accurate quantification of gene 
expression levels. For precise comparisons of gene expression levels between samples, 
determine Cq values for a gene only when the threshold line has been defined uniformly 
for all samples being analyzed. While the threshold can be set manually or automatically 
using the instrument’s software, it is important that the same numerical threshold value be 
used across all samples, whether they are on the same or multiple plates. The threshold is 
typically placed at least 10 standard deviations above the average baseline fluorescence 
level where the PCR reaction is undergoing exponential amplification. As an example, 
300 rfu was used as the uniform threshold line setting for all PrimePCR assay validation 
experiments on a CFX384 instrument.

Multiplex Assay Considerations
PrimePCR probe assays have been optimized to work under the same thermal cycler 
conditions, allowing for multiple assays to be used in the same well with different 
fluorophores. To ensure data generated in a multiplex reaction are equivalent to data 
generated in a singleplex reaction, it is imperative to evaluate the assay performance in  
both multiplex and singleplex reactions. It is also important to understand the expression 
level of your target sequences, as this will impact the multiplex optimization method. 
Consult the SsoAdvanced Universal Probes Supermix Instruction Manual for more details 
on multiplexing. 

Below is a brief list of considerations when conducting multiplex reactions:

■■ Determine expression levels of gene targets

■■ Use brighter fluorophores for lower expressing targets

■■ Compare standard curve of singleplex reaction to multiplex reaction

■■ Efficiency of multiplex reaction must be similar to minimize amplification bias

■■ Target abundance should not vary greatly between multiplex assays
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2	 Gene Expression Protocols

This chapter provides protocols for RNA isolation, cDNA synthesis, real-time PCR reaction 
setup (in each PrimePCR™ format), and the real-time PCR instrument run. Please follow the 
appropriate protocol for the format of your experiment (individual assays, 96- or 384-well 
plates). Remember to set up controls alongside reverse transcription and PCR reactions.

Overview: Real-Time PCR Workflow
Step 1: Isolate RNA
■■ Aurum™ total RNA mini kit

■■ Aurum total RNA fatty and fibrous kit

Step 2: Synthesize cDNA
■■ iScript™ family of reverse transcription reagents

Optional: Prepare Preamplification Reaction

−− PrimePCR PreAmp assays

−− SsoAdvanced PreAmp supermix

Step 3: Prepare Real-Time PCR Reaction
■■ PrimePCR assays and panels 

■■ SsoAdvanced™ universal supermixes

Step 4: Cycle in Real-Time PCR Instrument
■■ CFX real-time PCR detection systems

Step 5: Analyze Gene Expression Data
■■ CFX Manager™ software

■■ PrimePCR analysis software
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Step 1: Isolate RNA
1.	 Isolate and purify the RNA sample(s) using Aurum isolation kits or a similar product.  

The Aurum total RNA mini kit (catalog #732-6820) and the Aurum fatty and fibrous tissue 
kit (catalog #732-6830) enable RNA isolation from a wide range of cells and tissues and 
include a DNase digestion step to ensure DNA-free total RNA. Refer to the instruction 
manual for the detailed protocol.

2.	 Analyze the RNA sample for integrity and purity. 

a.	 Use Bio-Rad’s Experion™ automated electrophoresis system, the Agilent Bioanalyzer, 
or similar system to evaluate the integrity of the RNA sample. For gene expression 
analysis, ensure that the RNA quality indicator (RQI) or RNA integrity number (RIN) 
values are similar between samples to yield accurate qPCR results. An RQI value of 
10 indicates intact RNA, whereas a value of 1 indicates degraded RNA.

b.	 Use an agarose gel to assess RNA integrity if the above systems are not available. 
High-quality eukaryotic RNA yields two clean peaks, 18S and 28S. Degraded RNA 
appears as a smear on the gel. 

c.	 To assess purity, evaluate the following spectrophotometer readings:

A260/A280 > 2.0 for pure RNA (assesses DNA contamination)

A260/A230 ~2.0 for pure RNA (assesses protein contamination)

Lower ratios indicate the presence of contaminants such as salts, carbohydrates, 
peptides, proteins, phenols, and guanidine thiocyanate.

3.	 Assess total RNA concentration using a SmartSpec™ Plus spectrophotometer or similar 
instrument.

4.	 Normalize RNA concentration across samples by diluting in nuclease-free water.

5.	 Store RNA sample(s) at –80°C in single-use aliquots and at equivalent concentrations.

Step 2: Synthesize cDNA
Use the iScript family of reverse transcription reagents for cDNA synthesis. The iScript 
advanced cDNA synthesis kit was used during wet-lab validation of PrimePCR assays. In a 
single 20 µl reaction, this two-tube kit provides increased data throughput and the widest 
possible linear dynamic range through its loading capacity of up to 7.5 µg total RNA.

1.	 Thaw kit contents and normalized RNA samples on ice. Mix components thoroughly, 
centrifuge briefly to collect solutions at the bottoms of tubes, and then store on ice.

2.	 Use the same amount of RNA in each cDNA synthesis reaction. Typically 1–5 µg total 
RNA is sufficient, but may be adjusted depending on abundance of target transcript.

Reagents Description

5x iScript advanced reaction mix (red cap) 5x reaction mix with dNTPs, oligo(dT), random primers, buffer, 
MgCl2, enhancers, and stabilizers

iScript advanced reverse transcriptase 
(orange cap)

iScript MMLV-RT (RNase H+) and RNase inhibitor

Nuclease-free water



PrimePCR Assays, Panels, and Controls for Real-Time PCR  |  9

3.	 For each RNA sample, prepare a cDNA synthesis reaction on ice.

4.	 If using the PrimePCR RT control assay, dilute the lyophilized RT control assay template 
in 200 µl nuclease-free TE (pH 7.5) or the same reagent used to dilute RNA samples. 
Keep the  template on ice. It will degrade similar to RNA samples if exposed to multiple 
freeze-thaw cycles, ambient temperatures, or RNases. When preparing the cDNA 
synthesis reaction, add 1 µl of the diluted RT control template.

Component Volume per Reaction

5x iScript advanced reaction mix 4 μl

iScript advanced reverse transcriptase 1 μl

RNA (100 fg to 7.5 µg)* Variable

RT control assay template 1 μl

Nuclease-free water Variable

Total volume 20 μl

* It may be necessary to optimize the amount of RNA input due to differences in target gene 
expression levels and sample availability. See step 6 for an example calculation. 

5.	 Incubate the complete reaction mix in a thermal cycler using the protocol below:

Reverse transcription: 30 min at 42°C

RT inactivation: 5 min at 85°C

6.	 Dilute the cDNA reaction to the desired volume for qPCR reactions. The ideal range of 
input cDNA per qPCR reaction is 1–25 ng. Altering the amount of input RNA or the level of 
cDNA dilution can optimize gene expression results for a given collection of genes. Below 
is a step-by-step example calculation from starting RNA input through amount of cDNA 
per qPCR reaction used for a PrimePCR 96-well panel with 96 unique gene targets:

1 µg RNA input per 20 µl RT reaction = 50 ng/µl          

Dilute cDNA to 100 µl = 10 ng/µl  

Use 1 µl diluted cDNA per 20 µl qPCR reaction  = 10 ng cDNA per reaction

Prepare and Run Preamplification Reaction (Optional)
For the unbiased amplification of small quantities of cDNA, follow the preamplification 
protocol prior to preparing the real-time PCR reaction.

Prepare Preamplification Assay Pool with PrimePCR PreAmp Assays
1.	 Add 5 µl of each PreAmp assay (up to 100 assays) to a microcentrifuge tube.

2.	 Bring total volume of assay pool up to 500 µl with nuclease-free water.

3.	 Mix thoroughly, briefly centrifuge, and store on ice.

4.	 Use 5 µl of the assay pool in a 50 µl reaction.

Note:  Assay pools are stable at 4°C for up to 30 days and at –20°C for up to 1 year. 
PrimePCR control assays are currently not compatible with preamplification.
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Prepare Preamplification Reaction
1.	 Thaw SsoAdvanced PreAmp supermix and cDNA samples. Mix thoroughly by inversion 

or by a 15 sec vortex. Centrifuge briefly to collect solutions at the bottom of each tube 
and then store on ice and protected from light.

2.	 Prepare preamplification reaction mix on ice. Good pipetting practice must be employed 
to ensure assay precision and accuracy.

Component Volume per Reaction Final Concentration

2x SsoAdvanced PreAmp supermix 25 μl 1x

PrimePCR PreAmp pool 5 μl 1x

cDNA sample Variable 250 ng–100 pg

Nuclease-free water Variable —

Total volume 50 μl —

3.	 Mix the reaction mix thoroughly to ensure homogeneity and dispense into a PCR tube or 
into the wells of a PCR plate.

4.	 Load the PCR tubes or plate into a thermal cycler and start the PCR run with the 
following thermal cycling protocol.

Step Temperature Time # of Cycles

Activation 95°C 3 min 1

Denaturation 95°C 15 sec 10–12

Annealing/extension 58°C 4 min 10–12

Hold 4°C ∞ 1

5.	 After run completion, the preamplification reaction can be stored at –20°C for up to  
12 months or at 4°C for up to 72 hr.

6.	 The completed preamplification reaction should be diluted to a minimum of 1:5 with  
TE buffer. However, a larger dilution volume may be required, depending on the number 
of assays planned for downstream qPCR and the number of technical replicates. 
For example, a 1:15 dilution will provide enough volume for 100 qPCR assays using 
technical triplicates and 2 µl per reaction.

100 qPCR assays in triplicate = 100 assays x 3 replicates x 2 µl = 600 µl needed

1:15 preamplification reaction dilution = 750 µl  

150 µl excess

7.	 Use 2 µl of the dilution per 20 µl qPCR reaction or 1 µl per 10 µl qPCR reaction for a 
96- or a 384-well plate, respectively.

Note:  When using SsoAdvanced universal SYBR® Green supermix for qPCR after 
preamplification, run the activation and denaturation steps at 98°C if delayed Cq values or 
decreased efficiency occur.
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Step 3: Prepare Real-Time PCR Reaction
Protocols for preparing real-time PCR reaction mix are described according to format  
(96-well plates, 384-well plates, or individual assays). Protocols for PrimePCR control 
assays are incorporated into the reaction setup. Please refer to Chapter 3 for interpretation 
of experimental control assays.

Pathway/Disease Panel or Custom Plate — 96-Well Format
Primers are lyophilized in each well; therefore, add all remaining components to the PCR 
reaction mix.

1.	 Thaw SsoAdvanced™ universal SYBR® Green supermix, cDNA samples, and positive 
PCR control DNA template (if a PCR control assay is on the plate). Mix thoroughly by 
inversion or a 15 sec vortex, centrifuge briefly to collect solutions at the bottoms of 
tubes, and then store on ice and protected from light.

2.	 Allow the PrimePCR plate to come to room temperature prior to removing the seal.

3.	 Dilute each cDNA sample to a total volume of 100 µl if preparing a 96-well plate with 
unique targets.

4.	 Prepare (on ice or at room temperature) enough reaction mix for all qPCR reactions by 
adding all required components. Scale up proportionally for multiple reactions.  
CFX Manager™ software has an easy-to-use master mix calculator that provides  
scale-up calculations for your experiment.

Component Volume per Reaction Final Concentration

20x PrimePCR assay Dried in well 1x

2x SsoAdvanced™ universal SYBR® Green 
supermix

10 μl 1x

cDNA sample 1–4 μl* 100 ng–100 fg*

Nuclease-free water Variable —

Total volume 20 μl —

* Calculated during Step 2, cDNA synthesis. Avoid adding >20% reaction volume (4 µl) of cDNA   
sample to avoid excessive carryover of PCR inhibitors.

5.	 Transfer 20 µl of the PCR reaction mix into each well. 

6.	 Optional: Add 1 µl PCR control assay template into the appropriate well (total volume 
will be 21 µl — additional volume will not affect the qPCR reaction).

7.	 Seal the plate with an optical seal. Optional: briefly centrifuge to remove bubbles (4,000 rpm 
for 2 min at room temperature).

8.	 Load the PCR plate into the real-time PCR instrument.



12  |  PrimePCR Assays, Panels, and Controls for Real-Time PCR

Pathway/Disease Panel or Custom Plate — 384-Well Format
Primers are lyophilized in each well; therefore, add all remaining components to the PCR 
reaction mix.

1.	 Thaw SsoAdvanced™ universal SYBR® Green supermix, cDNA samples, and positive 
PCR control DNA template (if a PCR control assay is on the plate). Mix thoroughly by 
inversion or a 15 sec vortex, centrifuge briefly to collect solutions at the bottoms of 
tubes, and then store on ice and protected from light.

2.	 Allow the PrimePCR plate to come to room temperature prior to removing the seal.

3.	 Dilute each cDNA sample to a total volume of 400 µl if preparing a 384-well plate with 
unique targets.

4.	 Prepare (on ice or at room temperature) enough reaction mix for all qPCR reactions by 
adding all required components. Scale up proportionally for multiple reactions.  
CFX Manager software has an easy-to-use master mix calculator that provides easy 
scale-up calculations for your experiment.

Component Volume per Reaction Final Concentration

20x PrimePCR assay Dried in well 1x

2x SsoAdvanced™ universal SYBR® Green 
supermix

5 μl 1x

cDNA sample 0.5–2 μl* 100 ng–100 fg*

Nuclease-free water Variable —

Total volume 10 μl —

* Calculated during Step 2, cDNA synthesis. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.

5.	 Transfer 10 µl of the PCR reaction mix into each well. 

6.	 Optional: Add 0.5 µl PCR control assay template into the appropriate well (total volume 
will be 10.5 µl — additional volume will not affect the qPCR reaction).

7.	 Seal the plate with an optical seal. Optional: briefly centrifuge to remove bubbles (4,000 rpm 
for 4 min at room temperature). 

	 Note: Be careful to not introduce bubbles during pipetting steps, since it is difficult to 
remove bubbles from 384-well plates. 

8.	 Load the PCR plate into the real-time PCR instrument.

Individual Assays
Protocols for primer assays, probe assays, and control assays follow. PrimePCR individual 
assays come ready to use as a 20x stock solution.
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SYBR® Green Assay

1.	 Thaw SsoAdvanced™ universal SYBR® Green supermix, PrimePCR™ SYBR® Green 
assay, cDNA samples, and positive PCR control (if used) to room temperature. Mix 
thoroughly by inversion or a 15 sec vortex, centrifuge briefly to collect solutions at the 
bottoms of tubes, and then store on ice and protected from light.

2.	 Prepare (on ice or at room temperature) enough reaction mix for all qPCR reactions 
by adding all required components. PrimePCR™ SYBR® Green assays are provided 
as a 20x stock solution. Scale up proportionally for technical replicates. CFX Manager 
software has an easy-to-use master mix calculator that provides easy scale-up 
calculations for your experiment.

Component Volume per Reaction Final Concentration

96-Well 384-Well

20x PrimePCR assay 1 μl 0.5 μl 1x

2x SsoAdvanced universal SYBR® Green 
supermix

10 μl 5 μl 1x

cDNA sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-free water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA synthesis. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.

3.	 Transfer the appropriate volume of the PCR reaction mix into each tube or well: 20 µl for 
a 96-well plate, or 10 µl for a 384-well plate. 

4.	 Optional: Set up control reactions to determine sample quality and PCR and RT 
reaction performance.

5.	 Seal the plate with an optical seal. Optional: briefly centrifuge to remove bubbles (4,000 rpm 
for 2 min at room temperature).

6.	 Load the PCR plate (or tubes) into the real-time PCR instrument.

Probe Assay

1.	 Thaw SsoAdvanced universal probes supermix, PrimePCR probe assay, cDNA samples, 
and positive PCR control (if used) to room temperature. Mix thoroughly by inversion or 
a 15 sec vortex, centrifuge briefly to collect solutions at the bottoms of tubes, and then 
store on ice and protected from light.

2.	 Prepare (on ice or at room temperature) enough reaction mix for all qPCR reactions  
by adding all required components. PrimePCR probe assays are provided as a 20x 
stock solution. Scale up PCR reaction mix proportionally for technical replicates.  
CFX Manager software has an easy-to-use master mix calculator that provides easy 
scale-up calculations for your experiment.
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Component Volume per Reaction Final Concentration

96-Well 384-Well

20x PrimePCR assay 1 μl 0.5 μl 1x

2x SsoAdvanced universal probes supermix 10 μl 5 μl 1x

cDNA sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-free water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA synthesis. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.

3.	 Transfer the appropriate volume of the PCR reaction mix into each tube or well: 20 µl for 
a 96-well plate, or 10 µl for a 384-well plate. 

4.	 Optional: Set up control reactions to determine sample quality and PCR and RT 
reaction performance.

5.	 Seal the plate with an optical seal. Optional: briefly centrifuge to remove bubbles (4,000 rpm 
for 2 min at room temperature).

6.	 Load the PCR plate (or tubes) into the real-time PCR instrument.

Positive PCR Control Assay (PCR)

1.	 For each cDNA sample, prepare a positive PCR control reaction mix (template and assay 
in the same tube).

Component Volume per Reaction Final Concentration

96-Well 384-Well

20x PrimePCR positive PCR control assay 1 μl 0.5 μl 1x

2x SsoAdvanced supermix 10 μl 5 μl 1x

cDNA sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-free water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA synthesis. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.

2.	 Follow the remainder of the PrimePCR cycling protocol.

3.	 Assess performance of the qPCR reaction (see Chapter 3, Interpretation of Experimental 
Control Assays).

Reverse Transcription Control Assay (RT)

1.	 Resuspend lyophilized RT control assay template in 200 µl nuclease-free TE (pH 7.5) or the 
same reagent used to dilute RNA samples. Keep template on ice. It will degrade similar to 
RNA samples if exposed to multiple freeze-thaw cycles, ambient temperatures, or RNases.
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2.	 For each RNA sample, include 1 µl of the control RNA template in each 20 µl cDNA 
synthesis reaction, and proceed with the reverse transcription reaction. 

3.	 Once cDNA is synthesized and diluted to working stock, prepare a reverse transcription 
control reaction mix.

Component Volume per Reaction Final Concentration

96-Well 384-Well

20x PrimePCR RT control assay 1 μl 0.5 μl 1x

2x SsoAdvanced supermix 10 μl 5 μl 1x

cDNA sample with RT control template 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-free water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA synthesis. Avoid adding >20% reaction volume of cDNA 
sample to avoid excessive carryover of PCR inhibitors.

4.	 Follow the remainder of the PrimePCR cycling protocol.

5.	 Assess performance of the RT reaction (see Chapter 3, Interpretation of Experimental 
Control Assays).

DNA Contamination Control Assay (gDNA)

1.	 For each cDNA sample, prepare a DNA contamination control reaction mix.

Component Volume per Reaction Final Concentration

96-Well 384-Well

20x PrimePCR gDNA control assay 1 μl 0.5 μl 1x

2x SsoAdvanced supermix 10 μl 5 μl 1x

cDNA sample with RT control template 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-free water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA synthesis. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.

2.	 Follow the remainder of the PrimePCR cycling protocol.

3.	 Assess performance of the RT reaction (see Chapter 3, Interpretation of Experimental 
Control Assays).

RNA Quality Assay (RQ1 and RQ2)

1.	 For each cDNA sample, prepare RQ1 and RQ2 RNA quality assay reaction mixes.
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Component Volume per Reaction Final Concentration

96-Well 384-Well

20x PrimePCR RQ1 assay 1 μl 0.5 μl 1x

2x SsoAdvanced supermix 10 μl 5 μl 1x

cDNA sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-free water Variable Variable —

Total volume 20 μl 10 μl —

Component Volume per Reaction Final Concentration

96-Well 384-Well

20x PrimePCR RQ2 assay 1 μl 0.5 μl 1x

2x SsoAdvanced supermix 10 μl 5 μl 1x

cDNA sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-free water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA synthesis. Avoid adding >20% reaction volume of cDNA sample to 
avoid excessive carryover of PCR inhibitors.

2.	 Follow the remainder of the PrimePCR cycling protocol.

3.	 Assess performance of the qPCR reaction (see Chapter 3, Interpretation of Experimental 
Control Assays).

Step 4: Cycle in Real-Time PCR Instrument
Load the PCR tubes or plate on the real-time PCR instrument and program the thermal 
cycling protocol according to the following table. Start the real-time PCR run. 

Step Temperature Time No. of Cycles

Activation 95°C 2 min* 1

Denaturation 95°C 5 sec 40

Annealing/Extension 60°C 30 sec 40

Melt Curve** 65–95°C  
(O.5°C increments)

5 sec/step 1

* 	 Activation can be reduced to 30 sec. Do not use a 10-min activation time with Bio-Rad supermixes.

** Melt curve step is for SYBR® Green analysis only.

Step 5: Analyze Gene Expression Data
Process your data and evaluate results using CFX Manager or other analysis software. See 
Chapter 5, CFX Manager Quick Guide, or consult your instrument and software manuals for 
detailed instructions. If PrimePCR control assays were used, refer to Chapter 3 to interpret 
sample quality and reaction performance.
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3	 Interpretation of 
Experimental Control Assays

PrimePCR™ experimental control assays are designed to help assess the quality of your 
sample(s) and how this may affect the performance of the reverse transcription and qPCR 
reactions. They work alongside any assay from any source. This chapter explains how 
to interpret control assays. For control assay reaction setup, refer to the format (plate or 
individual assay) in Chapter 2, Gene Expression Protocols.

Positive PCR Control Assay (PCR)
Purpose: The positive PCR control assay (PCR) targets a synthetic DNA template to 
determine if samples contain inhibitors or other factors that may negatively affect your gene 
expression results. The sequence of the synthetic DNA template is not present in the human 
or mouse genome.

Designed to qualitatively assess:

■■ Performance of a qPCR reaction associated with a single sample

■■ Relative performance of the qPCR reactions associated with different samples

Format:

■■ Individual assay — 200 reactions (20x stock solution includes primers and DNA template)

■■ 96-well or 384-well plate — primers are lyophilized in designated well(s) on the plate, and 
the DNA template is provided in a separate tube
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Interpretation:

■■ Single sample — Cq ≥ 30 indicates poor PCR performance; will likely compromise gene 
expression results

■■ Two or more samples — designate one of your samples as the control. To determine the 
ΔCq between the control sample and each remaining sample, use the following equation:

|(PCR Cq for control sample) – (PCR Cq for sample)| = ΔCq

ΔCq > 1 indicates samples differ in their impact on qPCR performance and may 
compromise gene expression results.

Reverse Transcription Control Assay (RT)
Purpose: The reverse transcription (RT) control assay introduces a synthetic RNA template 
into the cDNA synthesis reaction to evaluate the RT performance. The sequence of the 
synthetic RNA template is not present in the human or mouse transcriptome.

Designed to qualitatively assess:

■■ Performance of a reverse transcription reaction associated with a single sample

■■ Relative performance of the reverse transcription reactions associated with different 
samples

Format:

■■ Individual assay — 200 reactions of 20x stock solution PrimePCR reverse transcription 
control primer assay and 200 reactions lyophilized RNA template

■■ 96-well or 384-well plate — primers are lyophilized in designated well(s) on the plate, 
and the lyophilized RNA template is provided in a separate tube

Interpretation:

■■ Single sample — Cq ≥ 30 indicates poor reverse transcription reaction performance; will 
likely compromise gene expression results

■■ Two or more samples — designate one of your samples as the control. To determine the 
ΔCq between the control sample and each remaining sample, use the following equation:

|(RT Cq for control sample) – (RT Cq for sample)| = ΔCq

ΔCq > 1 indicates that samples differ in their impact on reverse transcriptase 
performance and may compromise gene expression results.
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DNA Contamination Control Assay (gDNA)
Purpose: The DNA contamination control assay (gDNA) is a species-specific control assay 
that targets a nontranscribed region of the genome.

Designed to qualitatively assess:

■■ Whether genomic DNA (gDNA) is present in a sample at a level that may affect qPCR 
results

■■ Relative levels of gDNA contamination present in different samples to determine if qPCR 
results may be affected

Format:

■■ Individual assay — 200 reactions (20x stock solution)

■■ 96-well or 384-well plate — primers are lyophilized in designated well(s) on the plate

Interpretation:

Single sample: 

■■ Cq ≥ 35: indicates below single copy detection; no gDNA present

■■ Cq < 35: indicates the sample is contaminated with gDNA and gene expression results 
may be affected. The relative contribution of gDNA contamination to a sample’s signal 
can be determined by comparing the Cq value for a given gene of interest (GOI) to the Cq 
value for the DNA contamination control assay using the following equation:

|(GOI Cq) – (gDNA Cq)| = ΔCq

∆Cq Percent Contribution

1 50%

2 25%

3 12.5%

4 6.25%

5 3.13%

6 1.56%

7 0.78%

Two or more samples: Designate a sample as the control. To determine the ΔCq between 
the control sample and each remaining sample, use the following equation:

|(gDNA Cq for control sample) – (gDNA Cq for sample)| = ΔCq

■■ ΔCq < 1: samples have similar levels of gDNA contamination; gDNA contamination will 
likely have little to no effect on results

■■ ΔCq ≥ 1: samples have different levels of gDNA contamination; gDNA contamination may 
affect gene expression results
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RNA Quality Assay (RQ1 and RQ2)
Purpose: The RNA quality assay is a pair of assays (RQ1 and RQ2) that target the same 
transcript at different locations with different amplicon sizes. The RQ1 and RQ2 assays must 
be used as a pair for each cDNA sample. Differences in Cq values can indicate whether 
RNA degradation may be negatively impacting gene expression results.

Designed to qualitatively assess:

■■ Whether RNA integrity may adversely affect PCR results of a single sample

■■ Relative RNA integrity between samples to determine if qPCR results may be affected

Format:

■■ Individual assay — 200 reactions (20x stock solution) of RQ1 RNA quality assay and  
200 reactions (20x stock solution) of RQ2 RNA quality assay

■■ 96-well or 384-well plate — RQ1 and RQ2 primers are lyophilized in designated well(s) 
on the plate

Interpretation:

■■ Single sample — to determine the ΔCq between the RQ1 and RQ2 assays, use the 
following equation:

|(RQ2 Cq) – (RQ1 Cq)| = ΔCq

ΔCq ≤ 3.0: RNA degradation is minimal and will likely have little to no effect on gene 
expression results

ΔCq > 3.0: RNA integrity may compromise gene expression results

■■ Two or more samples — designate one of your samples as your control sample. To 
determine the ΔΔCq between the control sample and each remaining sample, use the 
following equation:

[ |(RQ2 Cq for designated control sample) – (RQ1 for designated control sample Cq)| ] – 
[ |(RQ2 Cq for sample) – (RQ1 for sample Cq)| ] = ΔΔCq

ΔΔCq = 0 to 1.0: samples are similar in quality; will likely have little to no effect on 
gene expression results

ΔΔCq = 1.0 to 2.0: RNA integrity differs; will likely have slight to moderate effects on 
gene expression results

ΔΔCq > 2.0: RNA integrity differs; will likely have significant effects on gene 
expression results
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4	 DNA Templates

PrimePCR™ DNA templates are single-stranded synthetic DNA templates that are 
complementary to corresponding gene-specific PrimePCR assays. Each template is linked 
to the corresponding assay with a Unique Assay ID. Templates for use with SYBR® Green 
assays are 60 base pairs in length, and those for use with probe assays are 90 base pairs in 
length. They are designed to give a positive real-time PCR result when used with the correct 
PrimePCR assay and can also be used to generate a standard curve.

Format: individual template — 200 reactions (20x stock solution) of assay-specific template 
(20 x 106 copies/µl)

Procedure:

1.	 For use as a qPCR control, prepare the reaction mix.

Component Volume per Reaction Final Concentration

96-Well 384-Well

20x PrimePCR assay for gene of interest 1 μl 0.5 μl 1x

2x SsoAdvanced™ supermix 10 μl 5 μl 1x

20x PrimePCR cDNA template for gene of interest 1 μl 0.5 μl 20 x 106 copies/μl

Nuclease-free water 8 μl 4 μl —

Total volume 20 μl 10 μl —

2.	 Follow the PrimePCR cycling protocol and evaluate results to determine assay 
performance.

Interpretation: When used as a qPCR control

■■ Cq < 30: assay performance is not affected

■■ Cq > 30: poor PCR performance; will likely compromise results

Standard Curve:

Perform a standard curve using a seven-point, tenfold serial dilution series from 20 million 
copies to 20 copies. Prepare serial dilutions of a stock solution of 10 ng/ml tRNA in TE (pH 8.0).
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5	 CFX Manager™ Software 
Quick Guide

For detailed instructions, please refer to your CFX instrument manual or CFX Manager 
software manual.

PrimePCR™ Run Setup
1.	 To begin a PrimePCR protocol, select the PrimePCR button from the Startup Wizard and 

go to File > New > PrimePCR run, or drag and drop a PrimePCR run file* onto the main 
window of CFX Manager.

2.	 Once a PrimePCR run has been selected, the Run Setup window opens in the Start Run 
tab. The PrimePCR default protocol and plate layout are loaded.

3.	 For SYBR® Green or FAM experiments, select the SYBR/FAM scan mode. For probe 
assays using other fluorophores (HEX and Tex615) or for multiplex experiments, open 
the Plate tab and use the Edit Selected option to choose the specific fluorophores and 
select the All Channels scan mode. 

4.	 For SYBR® Green assays, select Include Melt Step in the Protocol tab; deselect it for 
probe assays.

5.	 Once the plate and protocol are loaded, click Close Lid and Start Run.

* PrimePCR run files for predesigned and custom plates can be downloaded from www.bio-rad.com/primepcr. Custom plates are 
saved under My PrimePCR once configured and purchased. Predesigned panels have a Download Run File button on the Review 
Plate page.	



Data Analysis for Gene Expression Experiments
1.	 Drag and drop the PrimePCR run file for a predesigned or custom plate before or after a 

protocol run in order to populate the assay names for data analysis. Alternatively, open a 
data file by selecting File > Open > Data file. If analyzing data from multiple plates, skip 
to step 5 and set up a gene study.

2.	 The plate should contain sample and target information, as well as controls. Select 
reference targets in Experiment Settings.

3.	 Once the above requirements are met for normalized gene expression analysis, the 
Quantification and Quantification Analysis tabs of the Data Analysis window display a 
table of Cq values, averages, standard deviations, and normalized values.

4.	 Bar charts, clustergrams, scatter plots, volcano plots, and heat maps are available under 
the Gene Expression tab.

5.	 Create a gene study to compare gene expression data from one or more real-time PCR 
experiments using an inter-run calibrator to normalize between experiments. 

a.	 Go to File > New > Gene Study.

b.	 A Gene Study window opens. To add data files for the gene study, select File > Add 
Data File and choose the .pcrd data files you would like to analyze.

c.	 CFX Manager software automatically attempts an inter-run calibration (IRC) to 
normalize for variation between different plates. An inter-run calibrator must have 
the same sample and target between plates. If no such well exists on the PrimePCR 
plate, consider designating a positive PCR control well as the IRC, and be sure that 
the sample and target are labeled the same (for example, edit sample name to IRC 
and target to Positive PCR). 

6.	 After gene expression, generate analysis reports by selecting Tools > Reports… or 
export the data to Microsoft Excel by selecting Export > Export All Datasheets  
to Excel.

Note:  PrimePCR Analysis Software is available for real-time platforms not made by Bio-Rad. 
This enables easy PrimePCR plate file population with data (Cq values) generated on any 
real-time PCR instrument. Visit www.bio-rad.com/PrimePCR to download the software and 
instruction manual. 
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6	 Reference Gene Selection 
and Reference Gene Panels

To ensure proper normalization of loaded RNA in a gene expression experiment, use a 
stable, validated reference gene(s). The reference gene(s) should maintain consistent 
expression across all samples in the project regardless of treatment, source, or extraction 
method. The number used and specific choice of reference genes are key factors in 
determining the magnitude of change in expression that can be detected. To detect large 
changes (greater than fourfold), a single reference gene may be sufficient. For smaller 
changes (less than fourfold), use multiple well–validated reference genes to prevent 
confounding effects produced by fluctuations in basal or uninduced expression in any single 
reference gene. In addition, validate reference genes for stability using this method:

1. Choose candidate reference genes.
Select a candidate list of reference genes using published references as guidance. Use at 
least five reference genes for evaluation. For your convenience, Bio-Rad offers preplated 
reference gene panels using our validated and optimized PrimePCR™ assays. Each 
reference gene panel contains 14 reference genes commonly used in gene expression 
studies. The 96-well plate can accommodate up to six unique samples (or three samples in 
duplicate or two samples in triplicate), while the 384-well plate can accommodate 24 unique 
samples (or twelve samples in duplicate, eight samples in triplicate).

2. Select representative samples across the groups.
Select samples to represent all the conditions to be used in the study (for example, 
treatments, tissues, time courses), ensuring that all variables within the sample groups  
are evaluated.
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3. Isolate the RNA.
Isolate the RNA from the samples and treat with DNase using the same protocol for all 
samples. Quantify and normalize the RNA to the same concentration.

4. Perform reverse transcription to cDNA.
Perform a reverse transcription reaction for each sample using the same kit, column, and 
concentration. Dilute the cDNA, as needed, treating each sample the same to ensure there 
are no differences from sample to sample in terms of volume and concentration from the 
initial RNA input.

5. Analyze expression using real-time PCR.
Perform a real-time PCR experiment using the samples and the reference gene panel, or 
your selected reference gene assays.

6. Evaluate stability.
Statistical validation of reference gene stability is detailed in a study by Vandesompele  
et al. (2002) using an iterative test of pairwise variation. CFX Manager™ software includes 
this method as an automated dialog. To calculate the M value for each reference gene 
tested, open the data file in the Gene Expression tab and select Target Stability.  
The M values will be presented in tabular format in a dialog box. The lowest M value 
corresponds to the most stable expression in the tested samples, and recommended cutoff 
values for M are <0.5 (for homogenous sample sets) and <1 (for heterogenous sample sets). 
Reference gene stability can also be calculated using Biogazelle’s geNormPLUS or qbase+ 
software. Alternatively, use coefficient of variation (CV) or analysis of variance (ANOVA) 
methods to evaluate stability. 

Reference
Vandesompele J et al. (2002). Accurate normalization of real-time quantitative RT-PCR data by geometric averaging 
of multiple internal control genes. Genome Biol 3, RESEARCH0034.
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7	 MIQE Compliance

The minimum information for publication of quantitative real-time PCR experiments (MIQE) 
guidelines allow for greater transparency in qPCR data across laboratories. These guidelines 
allow scientists to investigate the quality of results presented and the ability to repeat 
experiments precisely. Bio-Rad’s PrimePCR™ assays make MIQE compliance easy. Each 
PrimePCR assay provides a Unique Assay ID, which can be easily tracked and reported in 
publications. These IDs are provided on the website when ordering and on the specifications 
sheets accompanying the product when shipping. Additionally, each PrimePCR assay has 
a thorough validation report that includes which transcripts for a given gene are targeted, 
and a context sequence where the amplicon can be found. For more information on how 
PrimePCR assays meet MIQE guidelines, refer to bulletin 6262 (found under the Documents 
tab at www.bio-rad.com/primepcr) or review the original publication (Bustin et al. 2009). 

Reference
Bustin SA et al. (2009). The MIQE guidelines: Minimum information for publication of quantitative real-time PCR 
experiments. Clin Chem 55, 611–622.
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8	 Frequently Asked Questions 
(FAQs)

How did Bio-Rad wet-lab validate PrimePCR™ assays?
Every primer pair was experimentally tested by generating an amplification plot using 
universal RNA, conducting a melt curve analysis, and calculating the efficiency and dynamic 
range from a seven-point standard curve using 20–20,000,000 copies of synthetic template. 
Specificity was determined by next generation sequencing of the amplicon.

Where can I find validation reports?
At www.bio-rad.com/primepcr, each assay has a PDF with validation data, including assay 
information, transcripts detected, validation graphs and values, and a key for interpreting data.

Can I multiplex PrimePCR probe assays?
The fluorophores chosen for PrimePCR probes assays enable multiplex experiments; 
however, not every combination of probe assays has been validated. Compare singleplex 
and multiplex reactions to determine the performance of multiplex experiments. See 
Multiplex Assay Considerations in Chapter 1.

Do I need to preamplify my cDNA?	
Preamplification is an optional step in the PrimePCR protocol. Performing preamplification 
will allow the user to perform more real-time PCR reactions from limited amounts of sample 
(10 pg–100 ng cDNA).

Will Bio-Rad provide primer sequence information?	
No. The MIQE context sequence of the amplicon is provided in the validation information. 
Exact sequences are not provided.
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What species does Bio-Rad offer?	
Human and mouse for qPCR, human for ddPCR™.

Can PrimePCR products be ordered using PunchOut?
Yes.

What does guaranteed performance mean?
Assay performs well when used with Bio-Rad amplification reagents and samples of 
sufficient quality.
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9	 Troubleshooting

Troubleshooting guide

Symptom Cause Treatment

Positive gDNA experimental control gDNA in sample Perform DNase digestion during RNA purification step

Positive NTC (no template control) DNA contamination in workflow Identify and eliminate source of contamination  
(plastics, reagents, workspace, etc.) 

Unexpectedly high Cq values and a  
positive PCR experimental control value

Possible PCR inhibitors in reaction Identify and eliminate inhibitor (see list of common 
inhibitors below) by purifying samples using a post-
isolation cleanup kit

Wells along edge of PCR plate are 
varying between technical repeats

Evaporation of PCR reactions	 Seal plate better before placing in thermal cycler; use 
a heat sealer for best results

Variability in reference gene Cq values 	
	

Expression of reference gene is not 
stable in RNA sample

Analyze expression levels of multiple reference genes 
from all sample/condition combinations and choose a 
stably expressed target(s)

RNA quality control assay is outside 
acceptable range		

RNA is degraded Prepare and purify a new RNA sample, keeping it at 
–80°C until use 
Limit freeze-thaw cycles 
Eliminate RNases from workspace/reagents

Spikes in early cycles of amplification 
traces

Bubbles present in wells and  
popping during cycling	

Take care when adding samples to plates, especially 
384-well plates. Position the pipet tips almost to the 
bottom and dispense sample into wells, being careful 
not to go to the second stop, which will expel a small 
air bubble into the sample

Standard curve using synthetic  
template does not appear to be linear, 
or efficiency is not close to what is  
described in the validation data	

Loss of synthetic template during 
serial dilutions	

Use 10 ng/µl of tRNA in TE (pH 8.0) when diluting 
template
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Common PCR inhibitors.

Source of Contamination

Sample Isolation Method

Melanin Ethanol >1% v/v

Polysaccharides Proteinase K

Hemoglobin DMSO >5%

Chlorophyll EDTA >50 mM

Polyphenolics SDS >0.01% w/v

Heparin Sodium acetate >5 mM

Humic acid Mercaptoethanol

Hematin Guanidinium

Phenol >0.2% v/v

DTT >1 mM
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10	Ordering Information

To order PrimePCR™ products, visit www.bio-rad.com/PrimePCR. All products must be 
ordered and quoted online to ensure correct assays of interest and configuration of panels. 
To check for availability of genes and determine the best panel based on your targets of 
interest, visit www.bio-rad.com/primepcr_lookup and use our easy lookup tool.

PrimePCR Assays, Panels, and Plates

Catalog#	 Description

100-25636 —100-25641	 SYBR® Green Assays

100-31225 — 100-31239	 qPCR Probe Assays

100-31240 — 100-31251	 ddPCR™ Probe Assays

100-25220 — 100-25225	 Custom Primer Assay

100-31261 — 100-31275	 Custom qPCR Probe Assay

100-31276 — 100-31281	 Custom ddPCR Probe Assay

100-25031 — 100-40427	 Predesigned Pathway/Disease Panels

100-25216 — 100-25219	 Custom 96-Well Plates

100-25210 — 100-25212	 Custom 384-Well Plates

100-25695	 Reverse Transcription Control Assay

100-25694 and 100-29103	 RNA Quality Assay

100-25591 and 100-29101	 Positive PCR Control Assay

100-25352 and 100-25352	 Genomic DNA Control Assay

100-31286	 Reverse Transcription Control Probe Assay

100-31287 and 100-32858	 RNA Quality Control Probe Assay
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Catalog#	 Description 

100-31288	 Positive PCR Control Probe Assay — FAM

100-31289	 Positive PCR Control Probe Assay — HEX

100-31290 and 100-32859	 Genomic DNA Control Probe Assay

100-25716	 Synthetic DNA SYBR® Control Templates

100-31285	 Synthetic DNA Probe Control Templates

100-41594	 Custom PreAmp Assay

100-41595	 SYBR® Green PreAmp Assay

100-41596	 Probe PreAmp Assay

Bulk Discounts

Please note that pricing and bulk discounting are subject to change.

Assay and Control Bulk Discounts
25% off 5 or more assays

Pathway and Collection Panel Bulk Discounts
25% off 5–9 plates 

45% off 10–19 plates 

60% off 20 or more plates

Custom Plate Bulk Discounts
Custom 96-well and 384-well plates with 1–96 unique genes: 

	 20% off 10–19 plates

	 35% off 20 or more plates

Custom 384-well plates with 97 or more unique genes:

	 20% off 20–29 plates

	 35% off 30 or more plates

Related Products
To learn more about Bio-Rad’s complete solution for real-time PCR, visit  
www.bio-rad.com/amplification.
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